
JMap Pro 7

User Manual

Copyright © 2001-2019 K2 Geospatial. All rights reserved.





 

JMap Pro 7 - User manual 
 
                                                                                  Copyright © 2001-2019 K2 Geospatial. All rights reserved.

Table of Contents

Welcome to JMap Pro 7
 
                                                                                                                       1

Graphical User Interface
 
                                                                                                                       2

Navigating on the Map
 
                                                                                                                          4

Map Management
 
                                                                                                                                  7

Map Settings
 
                                                                                                                                        10

Map Layers
 
                                                                                                                                          15

Elements Explorer ....................................................................................................................... 19

Thematic Maps ............................................................................................................................ 21

Layer Metadata ............................................................................................................................ 26

Layer Settings .............................................................................................................................. 27

General ................................................................................................................................... 29

Style ........................................................................................................................................ 30

Thematics .............................................................................................................................. 35

Labeling ................................................................................................................................. 41

Mouseover ............................................................................................................................. 44

Filters ...................................................................................................................................... 53

Advanced ............................................................................................................................... 54

Editable Layers ............................................................................................................................ 54

Editing Data ........................................................................................................................... 55

Personal Layers .................................................................................................................... 63

Tools
 
                                                                                                                                                     67

Labeling Tools ............................................................................................................................. 67

Selection Tools ............................................................................................................................ 67

Information Tools ......................................................................................................................... 69



 

JMap Pro 7 - User manual 
 
                                                                                  Copyright © 2001-2019 K2 Geospatial. All rights reserved.

Table of Contents

Snap Tools ................................................................................................................................... 75

Measurement Tools ..................................................................................................................... 77

Search Tools
 
                                                                                                                                        80

Collaboration Tools
 
                                                                                                                             85

Map Contexts ............................................................................................................................... 85

Sharing Maps ............................................................................................................................... 89

Printing Maps ............................................................................................................................... 91

Application Settings
 
                                                                                                                            98

Keyboard and Mouse Shortcuts
 
                                                                                                      100



1

JMap Pro 7 - User manual 
 
                                                                                  Copyright © 2001-2019 K2 Geospatial. All rights reserved.

Welcome to JMap Pro 7

Welcome to JMap Pro 7

JMap Pro is a downloadable mapping software from the JMap family (JMap Pro, JMap Web and
JMap Survey). JMap Pro connects to JMap Server to provide users an interactive map navigation,
analysis and data editing tool. JMap Pro can run on the web or over a private network and it can be
launched in standalone mode or via a web browser.

With all its rich tools and functionality, JMap Pro is the software of choice for many organizations
who wish to share mapping data with their employees because it is a powerful, yet user-friendly
solution. JMap Pro supports both vector and raster data. Lastly, JMap extensions can be integrated
to JMap Pro in order to expand its functionality.

This is the user manual for JMap Pro 7. 
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Graphical User Interface

Graphical User Interface

JMap Pro 7's graphical interface is modular (note that there is also a simplified version of JMap Pro
that does not permit the user interface to be reorganized). Each window can be moved to provide a
customized interface. To move a window, you must click on the top portion of it, then drag and
drop it to the desired area. You may want to hold down the Ctrl key when moving a window to avoid
automatically dropping it onto the sides of the application. Most windows include a set of display
options located in their upper right corner, allowing you to toggle to floating mode, to enable auto-
hide, and to close the window.

The following illustration shows the main parts of the interface.

The graphical user interface of JMap Pro

1 Map displaying a portion of data. It is possible to open several maps at once and organize
them according to your needs. Each map is independent from the others. Maps are
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Graphical User Interface

interactive and allow for easy querying of objects.

2 Toolbars and menu bars allow you to access the application's various functions.

3 The layer management window displays a hierarchical structure of the project's layers. You
may turn layers on or off as needed.

4 Extensions can be added to JMap to provide new functionalities. For example, the Edition
extension adds functionality to create and modify data.

5 The map overview shows the region displayed on the map in relation to the entire territory. It
also allows you to access a region in a single click. The overview can be activated from the
View menu. 

6 The elements explorer displays a tabular view of a layer's data or of selected data. The table
is interactively connected to the map.

7 Each map has a status bar indicating the coordinates, the scale, the number of selected
elements, etc.
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Navigating on the Map

Navigating on the Map

The following tools allow you to navigate on the map.

Navigation Tools

Zoom extent

Adjust map in order to display the whole of a project's data.

Zoom initial bounds

Returns to the view that was displayed upon opening the project.

Zoom in

Click on desired area of map to enlarge by a factor of 2.Trace a rectangle to enlarge the
chosen area.

Zoom out

Click on desired area of map to decrease size by a factor of 2. Trace a rectangle to
decrease size around the chosen area.

Pan

Move map by dragging it with the mouse. Click to center map view around the desired
point.

Backward

Return to previous view (the last 64 views are memorized).

Forward

Return to the view that was displayed before clicking on Backward (last 64 views are
memorized).

Zoom to selection

When objects are selected, adjusts map in order to display all selected data.

Rotation by points

Define map orientation by tracing a line defined by 2 points. The first point determines the
orientation of the bottom portion of the map and the second point (pointed by the arrow)
determines the orientation of the top of the map.
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Apply default map rotation

Cancels map rotation and returns map to its normal orientation.

Reaching Specific Coordinates on the Map

It is possible to reach specific coordinates on a map.

1. Click on the coordinates that appear in the status bar to display data entry window or select
Tools -> Go to coordinate... or press CTRL-G.

2. If desired, select the coordinate system (projection) to be used.

3. Enter coordinates to be reached.

4. Press Go.

The map centers itself around the requested coordinates, which are indicated by an arrow-shaped
marker. 

Coordinate input window
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Navigating Using the Map Overview

The map overview can be used to navigate on the map. In order to display it:

1. Go to View -> Map overview or press CTRL-O. Once it is activated, the map overview is
saved in the user's parameters.

2. Click in the map overview to re-center the map around the desired position. 

3. Drag the red rectangle to change the area displayed on the map.

Overview window showing the
displayed region using a red

rectangle
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Map Management

JMap Pro allows you to open several maps simultaneously; each map is independent from the
others. Thus, you can navigate in each map and display or hide layers in one map or another.
Maps can be piled one on top of the other or placed side by side to be viewed simultaneously.

Each map has a title, which is displayed on the title bar of the map window.

Opening a New Map

To open a new map: 

1. Go to Map -> New map or press Ctrl-N. The new map opens and is placed over the current
map. Maps that are piled this way are accessed by clicking on the tabs displaying the titles of
each map.

Tabs of 3 piled maps

Organizing Maps

To move a map:

1. Select it by clicking on its title bar or its tab.

2. Drag and drop it to the desired area. 

Note: Maps must be placed close to the sides of the application window. 

To organize several maps:

1. Place a map directly on another to pile them one on top of the other. 

OR

2. Select Map -> Tile maps horizontally or Map -> Tile maps vertically or Map -> Group
maps to organize maps according to your desired configuration.
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Examples of map configurations

Synchronizing Maps

Map synchronization allows you to navigate on several maps simultaneously. Each action
performed on a map is automatically replicated on all synchronized maps. In addition, the mouse
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pointer is also replicated on all synchronized maps. Synchronized maps can be useful to compare
information taken at different times on the same territory.

In order to synchronize maps:

1. Open at least 2 maps and place them side by side.

2. For each map you wish to synchronize, press  (located in the bottom left corner of each
map window). All maps are automatically synchronized with the first one and remain
synchronized afterwards. 

3. To stop synchronization, press the button again in each map window.

Full Screen View

Full screen view allows you to display a map occupying the entire space of the screen. All
components of the graphical interface are removed except for the status bar, which remains
available and is located underneath the map. The last active tool on the map remains functional. In
addition, all mouse and keyboard navigation shortcuts can be used to navigate on the map in full
screen mode.

To toggle between normal and full screen mode, press . You can also press Escape (ESC) to
exit full screen mode.
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Map Settings

Map Settings

Map settings allow you to define map display options, such as rotation, units, use of a north arrow,
and so forth. Map settings can be accessed from the map's pop-up menu (right-click on map). 

General

General map settings interface

1 Scale limits are used to limit the map's display scale. This prevents users from zooming too
far in or out.

• Maximum scale: Maximum scale limit for zooming in on the map.
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• Minimum scale: Minimum scale limit for zooming out on the map.

2 Application's map projection system.

3 Select units used on the map.

• Distance unit: The distance unit is used to display all distance-related values
(measurements, zoom level, etc.).

• Display unit: Unit used to display map coordinates.

4 • Background color: Select background color for map window. Background color appears
wherever there is no visible data.

• Default selection color: Select default selection color. Selected objects will be of this color
unless a different selection style is defined for their layer.

5 Enter rotation used to display map, in degrees. Rotation is performed clockwise.

Static elements

Static map elements are objects that are placed on fixed areas of the map. Two types of static
elements are available: the north arrow and graphic scale.
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Interface for configuring map static elements

1 Select the North Arrow option to enable the display of the north arrow on the map.
Afterwards, select the arrow model you wish to use. If the map is rotated, the north arrow will
indicate this rotation.

2 Select the arrow's position on the map. You can also offset the arrow from the chosen
position by entering values in pixels. In addition, the size of the arrow can be adjusted.

3 Enable the graphic scale to be displayed by selecting this option.
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Grid

A grid can be added to the map. This grid shows divisions and subdivisions of the coordinates
system. 

Grid configuration interface

1 Activate the grid.

2 Select this option to have the grid show the division lines. Specify the X and Y intervals
between the lines in the grid. You can also select the color of the division lines.

3 Select this option to have the grid show the subdivision lines. Specify the X and Y intervals
between the subdivision lines. You can also select the color of the subdivision lines. 
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Map Settings

4 You can add labels indicating the grid's coordinates and ticks on the edges of the grid (view
image below).

Example of a map with a grid
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Map Layers

In JMap, map data is organized in layers. These layers are displayed transparently on the map and
are piled one on top of the other. They are independent from one another and can be turned on or
off. Layer order is important as some more opaque layers can hide elements found in lower layers.
A layer must be visible in order to be displayed on a map and it must be selectable in order for
users to select its elements. 

The JMap administrator creates project layers as they appear when the project is opened. You can
change the order of the layers as well as other settings; these changes will be lost when closing
the application unless saved in a context. Refer to Layer Settings and Map Contexts for more
information.

The JMap administrator also determines the frequency of automatic updating for each layer, i.e.
how often your application will automatically reload the layer data from the JMap server.

Layer Management

The layer management window allows you to turn layers on and off, change the order of layers,
modify their settings, and so forth. Two displays are available for layer management: hierarchical
display and list display.

The hierarchical display shows the layers logically grouped together in a tree structure. The
hierarchy is defined by the JMap administrator. Each group of layers can be turned on or off. Layer
order is determined by the system administrator and does not necessarily reflect the order in which
layers are displayed on the map. When a group is turned on, all the visible layers it contains are
displayed. When a group is turned off, none of the layers it contains and none of the layers in its
sub-groups are displayed. Turning a group on or off does not affect the visibility of the layers it
contains.
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Layer manager window in hierarchy display

1 Press this button to switch to the hierarchical display.

2 Press this button to switch to the list display (view details below).
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3 When entering a query in the search field, only the layers whose name contain the contents
of your query will be displayed in the layer manager. 

4 The group of layers is invisible. None of the layers that are part of this group will be displayed
(even if some of them are checked as being visible). 

5 The layer is visible. Click on it to make it invisible.

6 The layer is visible, but the map's current scale does not allow it to be displayed. Placing the
mouse pointer over the check box allows you to view the scale at which the layer will be
visible. 

7 The layer is invisible. Click on it to make it visible.

8 This option allows you to perform the following (in a single click):

- make all layers selectable,

- make all layers not selectable,

- return to project default settings.

9 Graphical representation of layer on map.

When the layer is a thematic, clicking on it allows you to obtain its legend.

10 Pop-up menu, accessible for each layer.

11 This option allows you to access layer metadata. Refer to the Layer Metadata section.

12 Zoom to display the full extent of the layer, allowing you to view the entire territory on which
the elements of this layer are found. 

13 This option allows you to access the elements explorer.

14 This option allows you to make the layer selectable or not selectable.

15 This option allows you to access the layer's settings.

16 This option allows you to hide the layer manager, minimizing it into a tab.

17 This option allows you to close the layer management window.

18 This option allows you to access the filter.

The list display presents the map layers in an organized list; all layers are displayed at the same
level. The order of the layers in the list reflects the order according to which they are displayed on
the map. The layer at the bottom of the list is the first one drawn on the map, and the layer at the
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Map Layers

top is the last one drawn. This interface allows you to change layer order by dragging a layer up or
down in the list.

Layer management window in list display

1 The thematic is enabled. 

2 The thematic is disabled.

3 This option allows you to make the layer selectable or not selectable.
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4 The layer is visible, but the map's current scale does not allow it to be displayed. Placing the
mouse pointer over this check box allows you to view the scale at which the layer will be
visible. 

5 The layer is invisible.

6 This option allows you to access the layer's settings.

7 This option allows you to display the thematic's legend. 

8 A single click on this button brings you back to the hierarchical layer manager. 

9 When entering a query in the search field, only the layers whose names contain the contents
of your query will be displayed in the layer manager. 

Elements Explorer

The elements explorer displays the attributes that are bound to the layers' elements. Each table is
associated with a specific layer and each line in the table represents a layer element. This interface
offers several possibilities for working with attributes.

The elements explorer is displayed
from the layer management window  

Display the information of an element in the
explorer, from the pop-up menu on the map

The elements explorer can be enabled from the layer management window. It can also be opened
by right-clicking on a map element and selecting Show in explorer. The elements explorer will
open and select the row of attributes associated with the element. Conversely, double-clicking on a
row in the table will zoom in on the associated element in the map; the element will briefly flicker.



20

JMap Pro 7 - User manual 
 
                                                                                  Copyright © 2001-2019 K2 Geospatial. All rights reserved.

Map Layers

1 Each tab is associated with a layer. The name of the layer is indicated, along with the number
of elements that are loaded. The number of elements that are loaded on a layer can be
inferior to the total number of elements contained within the layer. In this case, a special note
("partial") is added to the title of the tab.

2 Each layer attribute is represented by a column in the table. The column header indicates the
attribute title. You can sort the table according to the values of an attribute by clicking on the
header of the corresponding column. You can also sort the table according to several
attributes by holding down the CTRL key and clicking on several headers. Lastly, you can
move a column by selecting its header and dragging it horizontally.

3 The check boxes of the first column are used to select elements. All elements that are
selected in the table will appear selected on the map. Conversely, all elements selected
using selection tools on the map will be selected in the table.

4 Press this button to enable edit mode. Edit mode allows you to modify attribute values and to
erase elements. This function is only available with editable layers including personal layers.

5 Press this button to enable the automatic zoom function. If this function is enabled, the
selected rows in the table will cause the map to zoom in on the associated map elements.

6 Press this button to enable the automatic highlight function. When this function is enabled,
the elements corresponding to the selected rows will blink on the map.

7 Press this button to select all of the layer's elements. 

8 Press this button to invert the selection on the layer. All selected elements will become
unselected and vice-versa. 

9 Press this button to unselect all of the layer's elements.

10 This button allows you to open the attributes table in a spreadsheet program such as Excel.

11 This button allows you to select the attributes to be displayed in the explorer.
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Thematic Maps

Thematic maps allow you to illustrate information pertaining to a particular theme. For example, a
thematic map on criminality could illustrate the various sectors of a city in different colors based on
the crime rate in each of these. A thematic map could also illustrate the results of an election by
representing a breakdown of the votes for each party in a pie chart. JMap allows you to create
customized thematic maps using the various layers that are available and their attributes. Some
thematics may be predefined by the JMap administrator but users can create new ones. Several
thematics may exist for the same layer and each of these may be enabled or disabled. Each
thematic has its own legend that can be displayed from the layer manager.

There are 2 categories of thematics in JMap: classifications and proportional quantities.

Classification Thematics

Classification thematics separate map elements into a number of classes (also called categories);
each class has its own display style, which causes certain visual variables to change (fill color,
stroke style, etc.). Therefore, all elements belonging to the same class share the same display
properties.

The various types of classification thematics are presented below.
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Graduated Styles

Graduated styles thematic

Graduated styles thematics use a graduation of one or more visual variables to represent the
elements of various categories.

Examples of graduating visual variables include: graduation of the fill color of polygons from white
to red; graduation of the size of an individual symbol from 1 to 5; graduation of the width of lines
from 1 to 4, and so forth. In all cases, there is a finite number of categories and every element of
the layer falls into one of these categories. Only numeric attributes can be used for this type of
thematic.

Several methods can be employed to calculate the value ranges for the categories of this type of
thematic. Refer to Method for Calculating Value Ranges for Categories for more information.

Graduated Symbols

Graduated symbols thematic

Graduated symbols thematics draw circular symbols on the map elements they qualify. The
symbol sizes graduate according to a finite number of categories based on a numeric attribute.
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Several methods can be employed to calculate the value ranges for the categories of this type of
thematic. Refer to Method for Calculating Value Ranges for Categories for more information.

Individual Values

Examples of individual values thematics

Individual values thematics display all elements of a given attribute possessing the same value with
the same graphical properties. This type of thematic does not use ranges of values but rather
specific values. There are as many classes as there are different values. The maximum number of
different values allowed is 512. If a layer has more unique values, it will not be possible to create
this type of thematic on that layer. Numeric and alphanumeric attributes can be used for this type of
thematic.

Individual Custom Values

Individual custom values thematics are similar to individual values thematics but they allow you to
add values to the ones existing in the data. This is useful when you create a thematic using a data
set that does not contain all the known possible values for an attribute at the time when the
thematic is created. 

Proportional Quantities Thematics

Proportional quantities thematics display map elements by using a continuous variation of a visual
variable based on a set of numeric attributes. No class is used, but an infinite number of displays
are possible.
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Proportional symbols

Proportional symbols thematics

Proportional symbols thematics draw circular symbols on the center of the elements they qualify.
The symbol sizes are determined by interpolation between the minimum and maximum values of a
given numeric attribute.

Pie Charts

Pie chart thematics



25

JMap Pro 7 - User manual 
 
                                                                                  Copyright © 2001-2019 K2 Geospatial. All rights reserved.

Map Layers

Pie chart thematics draw pie chart diagrams on the center of the elements they qualify. This type of
thematic is based on one or many numeric attributes. Each part of the diagram (piece of the pie) is
associated with a given numeric attribute. The size of the diagram is proportional to the sum of the
values of the element attributes; it is determined by interpolation between the minimum and
maximum values of the sums of the attribute values.

Bar Charts

Bar chart thematics

Bar chart thematics display bar chart diagrams (also called histograms), which are superposed on
the center of the elements they qualify. This type of thematic is based on one or more numeric
attributes. Each part of the diagram (bar) is associated with a given numeric attribute. The size of
the diagram is proportional to the sum of the elements' attribute values. It is determined by
interpolation between the minimum and maximum values of the sums of the attribute values.

Method for Calculating Value Ranges for Categories

Several different methods can be employed to calculate the value ranges for the categories of
graduated styles or graduated symbols thematics:

· Equal ranges: The ranges will be equal in size (e.g. 0-10,10-20, 20-30).

· Equal count: The range limits will be calculated so that an equal count of elements falls in each
class.

· Standard deviation:The range limits will be calculated so that the average value falls in the middle
of the range, and the range size for each category is equal to the value of the calculated standard
deviation.
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· Defined intervals: The range size is user-defined and constant for all categories.

· Percent ranges: The size of each range is expressed as a percentage of the full range of values
(e.g. 4 categories with 20%, 20%, 35% and 25%). The total must be equal to 100%.

· Custom ranges: All range limits are user-defined.

Layer Metadata

Information on the various layers of a project can be available in JMap Pro. This information could
include the source of data, the date the last update was performed, the quality of the data, etc. This
information, called layer metadata, is configured by the JMap administrator. 

If a layer has metadata, you can preview it by placing the mouse pointer on the name of the layer in
the layer manager.

Overview of a layer's metadata

To access the complete version of the metadata, you must click on the metadata button in the
layer settings menu. 
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Display of the complete metadata of a layer

Layer Settings

Layer settings allow you to define many options associated with map layers in JMap. The layer
settings management window is accessed from the layer management window. It can also be
accessed by double-clicking on the name of a layer. 
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Accessing layer parameters

All default settings have been set by the JMap administrator but you can modify these according to
your preferences. However, layer setting changes are made locally and will be lost at the end of
your session unless saved within a map context (see Map Contexts for more information).



29

JMap Pro 7 - User manual 
 
                                                                                  Copyright © 2001-2019 K2 Geospatial. All rights reserved.

Map Layers

General

This section presents the layer's general settings.

Interface for managing general layer settings

1
· Visible: Determines whether the layer is visible or invisible. Only visible layers are

displayed on the map.

· Selectable: Determines if layer elements are selectable. If this option is not selected, the
elements of the layer cannot be selected using the selection tools.

· Overview: Adds layer to application overview. Overview can be enabled by selecting
View->Map overview or by using the CTRL-O keyboard shortcut.

2 Visibility thresholds define the scale range within which a layer is displayed on the map. If the
displayed map scale does not fall within the minimum and maximum values, the layer will not
be displayed. If the options are not selected, thresholds will be ignored. If a layer is grayed out
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in the layer manager, this indicates that it is not displayed due to visibility thresholds.
Depending on what the JMap administrator has decided, it is possible that these options
cannot be modified.

Example of a layer not displayed because of the
visibility thresholds

3 Attributes that are bound to the layer's elements are presented in this table. Attribute titles and
types are indicated. Layer attributes are descriptive data associated with layer elements.
They are used for mouseover bubbles, labels, thematic maps, etc.

Style

The style determines the graphical representation of elements on the map. This section allows you
to modify the style of a layer's elements. There is a specific interface for each type of element
(point, line, polygon, text, image, etc.) but several settings are common to all types. You can also
define multiple styles for the same layer; each style is then used for a specific range of scales.
Lastly, you can modify the style of selected elements on a layer.

The following interface displays existing styles for a layer.
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Interface for managing layer styles

1 This list displays existing styles for the layer. Each style applies to a specific range of scales.

2 Press Add... to create a new style for a given range of scales. Select a row in the table and
press Delete in order to delete the corresponding style. 

3 By default, the selection style for a layer is automatically created from the layer style and
uses the project's default selection color. You can modify a layer's selection style by
checking Override selection style and clicking on the Edit... button.

General Style Properties

Some style properties are available for most types of elements.

Antialiasing is a method of representing perfect, continuous vectors on imperfect, discontinuous
display devices so that they look as perfect as possible. In every style configuration section of
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JMap, you can enable antialiasing. This will result in better looking maps. However, display
performances are reduced when antialiasing is enabled, so use it judiciously.

Example of polygon border with
antialiasing (left) and without

antialiasing (right)

Partial object transparency can be used for every type of map element. A map element with a
transparency value of 0% will be completely opaque, while one with a value of 100% will be
invisible.

Example of polygon with 50% (left) and 10% (right) transparency

The blinking function makes layer elements blink on the screen. This property is not normally
used for all of a layer's data but rather for a subgroup of elements with a thematic.

Style Properties for a Layer of Points

Style parameters

Symbol Select the symbol you wish to use to represent the elements. The
symbol can be a vector symbol or an image.

Vector symbols are provided with JMap and offer special
characteristics compared to images. They can be resized without
distortion and their fill color and border can be modified. However,
they cannot be customized easily.

Images are provided by the administrator and thus can be easily
customized.
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Size Specify the size of the symbol. A value of 1 corresponds to the
original size of the symbol or image.

Orientation Specify the rotation to apply to the symbol.

Rotate symbol with the map Select this option to have the symbol rotated when the map is
rotated. If this option is not selected, the symbol will maintain its
default angle, regardless of the map rotation.

Proportional size Select this option if you want the size of the symbols displayed to
vary in proportion to the map scale. You must enter the reference
scale at which the symbols will be displayed in their normal size. 

Offset symbol You can enter values in pixels to offset the symbol vertically (Y) or
horizontally (X). If the field indicates 0, 0, the symbol will be centered
on the coordinates of the point. 

Fill color Specify the color of the interior of the vector symbol. For vector
symbols only.

Transparent fill Select this option to have the inside of the vector symbol completely
transparent. For vector symbols only.

Line color Specify the color of the lines of the vector symbol. For vector
symbols only.

Border thickness Specify the thickness of the border of the vector symbol. For vector
symbols only.

Style Properties for a Layer of Lines

Style parameters

Line Specify the color of the line.

Line thickness Specify the thickness of the line, in pixels.

Stroke Specify the stroke style (dashed, solid, with border, etc.) to use to
draw the line. JMap provides many stroke styles.

Border color If the line has a border, specify its color. Refer to the Stroke
parameter above for information on choosing a line with a border.

Border thickness If the line has a border, specify its width. Refer to the Stroke
parameter above for information on choosing a line with a border.
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Arrow Specify the arrow option you wish to use:

None: No arrow.

Forward: Place an arrow on the line pointing towards the last point
of the line.

Backward: Place an arrow on the line pointing toward the first point
of the line.

Position (%) If an arrow is used, this parameter determines its relative position. A
value of 50% places the arrow in the center of the line.

Style Properties for a Layer of Polygons

Style parameters

Color Specify the color of the polygon's interior.

Transparent fill Select this option to have the inside of the polygon completely
transparent.

Pattern Specify the fill pattern to use. JMap provides many patterns.

Pattern color If a pattern is used, specify its color.

Transparent pattern fill If a fill pattern is used, select this option to make the pattern
background completely transparent.

Border color Specify the color of the polygon's border.

Border thickness Specify the thickness of the polygon's border.

Stroke Specify the stroke style (dashed, solid, with border, etc.) to use to
draw the border of the polygon. JMap provides many stroke styles.

Transparency (%) Specify the transparency to apply to the polygon's border.

Style Properties for Annotation (text) Layers

Style parameters

Font Specify the font used to display the text.
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Bold Select this option to use bold text.

Italic Select this option to use italicized text.

Underlined Select this option to use underlined text.

Outlined Select this option to use outlined text. The color of the outline may
differ from that of the text, which improves the readability of the
map.

Striked through Select this option to use text that is striked through.

Text color Specify the color of the text.

Outline color If outlined text is used, specify the color of the outline.

Style Properties for a Layer of Images

Only partial transparency may be adjusted for image layers.

Selection Style

Each layer possesses a selection style. Selection styles are used to represent elements when
they are selected on the map. By default, the selection style is automatically generated using the
layer's basic styles and the project's default selection color. 

To modify the selection style, select Override selection style and press the Edit... button.

Thematics

This section allows you to create or modify a layer's thematics. Each layer can have 0, 1 or more
thematics and each of these can be enabled or disabled. The JMap administrator can define the
default thematics that will be available for each layer of a project. As a user, you can also define
your own thematics. Refer to Thematic Maps for general information on thematics in JMap.
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Thematic management interface

1 This table shows the list of existing thematics for this layer. The first column is used to
enable or disable thematics. Only enabled thematics are displayed on the map.

2 These arrows are used to modify the order of the layer's thematics. If several thematics are
enabled at the same time on the layer, it is important to consider their order to avoid having
some layers hide others. It is normal that some thematics cannot be displayed
simultaneously.

3 Press New... to create a new thematic. The thematic creation interfaces vary depending on
the type of thematic selected.

Press Edit... to modify an existing thematic. Note that thematics created by the JMap
administrator cannot be modified. 

Press Duplicate to copy the selected thematic. An identical thematic will be created with a
new name.
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Press Delete to delete the selected thematic(s).

Creating Classification Thematics

Creating a graduated styles thematic

To create a new thematic of this type, you need to select the numeric attribute to use, define the
number of categories, select the range calculation method and define the category styles.

There are several methods for calculating the ranges of values for the categories of this type of
thematic. See Methods for calculating ranges for more information.

Attribute

Attribute Select the numeric bound attribute to use.

Do not draw elements with out-
of-sample values

If this option is selected, elements with values outside of the
value range will not be displayed. This can happen when the
data is modified after the thematic was created.

Create a category for null
values

Select this option if you want null values to be represented in the
thematic. 

Categories

Categories Enter the desired number of categories.

Range method Select the method used to determine the bounds of the value
ranges. Refer to Methods for calculating ranges for more
information.

Remove duplicated categories In some cases, categories can have the exact same value
limits. Select this option to avoid having identical categories. This
can happen with very small data sets or if limits are rounded to
big numbers.

Round at Select the precision to use to round category range limits. It is
often more useful to have rounded limits than very precise ones
(e.g. country populations rounded to the nearest million).

The next section allows you to define the styles of the categories. There are two possibilities:
create custom range styles or use predefined color schemes.
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Custom range styles

You must define the from and to values of the style by indicating the style variables that will vary
(e.g. border thickness, symbol size, fill color, etc.). The category styles are then generated by
interpolation between the from and to styles. Optionally, a third style can be used to create an
inflexion point. If an inflexion is defined, the generated styles will pass through the inflexion point at
the specified position in percentage. The interface is different based on the element type of the
layer.

Custom range styles

Use inflexion point at Select this option to use an inflexion point and specify the
position of the inflexion.

Edit base style Use this link to modify the style of the layer without leaving the
Thematics section. The base style is used to produce the styles
of the categories.

Color schemes

Instead of manually defining styles, you can select a color scheme to generate the styles of the
thematic's categories.

Color schemes

Type 3 types of color schemes are available:

Sequential: The colors form a gradient of sequential colors (e.g.
from white to red).

Diverging: The colors form a gradient with a central color (e.g.
from blue to white to red). Here emphasis is placed on central
categories.

Qualitative: Colors do not follow any sequence.

Apply to You can choose to apply the palette to the available visual
variables (e.g. fill, border, etc.), depending on the type of element
on the layer.

Creating a graduated symbols thematic

Only numeric attributes can be used for this type of thematic. 

There are several methods for calculating the ranges of values for the categories of this type of
thematic. See Methods for calculating ranges for more information.
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The creation process is the same as for creating a graduated styles thematic, as described above.

Creating an individual values thematic

Numeric and alphanumeric attributes can be used with this type of thematic.

To create a new thematic of this type, basically all you need to do is to select the attribute to use.

Individual values thematic

Attribute Select the bound attribute to use. It can be numeric or
alphanumeric.

Do not draw elements with out-
of-sample values

If this option is selected, elements with values not present in the
value sample will not be displayed. This can happen when the
data is modified after the thematic was created.

Create a category for null values Select this option if you want null values to be represented in the
thematic.

JMap uses random colors for this type of thematic. You can modify styles manually or click on
Color Schemes to use a predefined color scheme.

Creating an individual custom values thematic

Numeric and alphanumeric attributes can be used with this type of thematic.

The creation process is similar to creating an individual values thematic, except that you have the
option to modify the list of individual values by adding, removing or modifying categories.

Creating Proportional Quantities Thematics

Creating a proportional symbols thematic

Only numeric attributes can be used for this type of thematic.

To create a new thematic of this type, you need to select the numeric attribute to use and define
the from and to styles. The symbol size and color will be interpolated between the from and to
values.

Creating a pie charts thematic

Only numeric attributes can be used for this type of thematic.

To create a new thematic of this type, you need to select one or more numeric attributes to use
and define the chart style.
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Pie charts thematic

Attributes Select one or more numeric attributes. Each attribute will be
represented by a piece of the pie chart. The size of the chart will
be determined by the sum of those attribute values.

Do not draw elements with out-
of-sample values

If this option is selected, elements with values not present in the
value sample will not be displayed. This can happen when the
data is modified after the thematic was created.

Ignore negative values Select this option to ignore negative values.

Pie chart style

Chart size Select the from size (smaller) and the to size (bigger). The
chart size will be determined by interpolation between these two
values.

Border thickness To draw a border around the chart, select a non zero border
thickness.

Start angle Select one of the directions to use as the starting angle of the
chart. The first piece of the pie chart will start at the specified
angle. 

Draw shadow Select this option to draw a shadow for the pie charts.

Labels Select the label type (or none) to indicate the value or relative
percentage of each piece of the pie chart.

Colors Select the color of each portion of the pie chart.

Creating a bar charts thematic

Only numeric attributes can be used for this type of thematic.

The creation process is similar to creating a pie charts thematic, as described above.

Creating a legend

The last step in creating any type of thematic consists of creating its legend.

Legend
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Title Enter a title for the legend.

Subtitle Enter a subtitle for the legend.

Dynamic legend For classification thematics only. Check this option to make the
legend dynamic. A dynamic legend is constantly refreshed to
display only the classes that are visible on the map displayed. 

Preview A preview of the thematic is displayed. 

Labeling

The Labeling section allows you to modify the settings of the layer's labeling tools, including the
labels' contents (displayed text), look, and so forth. As a user, you can customize these settings.
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Interface for managing a layer's labels

1 Enter the text of the layer's label. Use the ev(attrib) function to insert the attribute value
specified in parenthesis. The attributes list allows you to select attributes and add them to the
label text simply by pressing the button with the down arrow. Labels also support javascript
programming to perform mathematic operations as well as operations on character strings
using attribute values. The text can span several lines.

2 Press this button to modify the display style of the label text (font, size, color, etc.). 

3 Enable automatic labeling in order to automatically display labels for layer elements
according to specified parameters. 

4 The maximum and minimum scales are used to limit automatic labeling to a certain range of
scales.

5 Select the position of the label in relation with the element it identifies. Some positions are not
available for all types of elements.
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6
· Allow overlapping: Allows labels of the current layer to overlap each other and overlap

labels of other layers.

· Prevent duplication: Filters labels to be displayed in order to avoid repeating the same
text. If several labels have the same text, only the first one will be displayed. This function is
useful for street names.

· Parse numeric labels: If the label contains both text and numeric values, only the numeric
values will be displayed. Useful when you want to display only highway numbers using an
attribute containing other text (e.g. "Highway 40" becomes "40").

7
· Symbol under labels: Select this option to choose a symbol that will be displayed under

the label text. Note that the label text must fit inside the selected symbol. This option is
mostly used for highway symbols containing highway numbers.

· Frame: Select this option to draw a frame around the label text. 

· Color: You can select the color of the frame's background.

· Border color: You can select the color of the frame's border.

· Proportional size: By default, label text is always displayed with the specified font size,
independently of the scale of the map. Use this option to have the label text size adjusted
proportionally to the scale of the map. The text will appear in the specified font size when
the map is displayed at the specified reference scale. When the scale of the displayed map
is changed, the text size will be modified accordingly.

8 Rotation options allow you to control the way labels are rotated.

· Attribute: Choose the attribute containing the rotation to apply to each layer symbol. Only
numeric attributes are available.

· Direction: If an attribute is used for the rotation, indicate the direction of the rotation
(clockwise or counterclockwise). 

· Follow map rotation: Select this option to have labels follow map rotation. If a map rotation
is set, the same rotation will apply to the labels.

Example of curved labels (left) and labels with a frame (right)
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Example of labels with a background symbol

Mouseover

This section allows you to define mouseover settings for the layer, such as the contents to be
displayed, the color of the mouseover bubble, etc. 
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Mouseover configuration interface

1 The Attributes list allows you to select attributes and add them to the mouseover bubble's
contents by pressing the button with the downward arrow.

2 The Functions list allows you to select content formatting functions (bold, italic, etc.) and to
add these to the mouseover bubble's contents by pressing the button with the downward
arrow.

3 Enter the mouseover bubble's contents. This can include static text, as well as functions
displaying attribute values, images, etc. Mouseover bubbles also support javascript
programming to perform mathematic operations as well as operations on character strings
using attribute values.

For more information on defining the content of mouseover bubbles, refer to Creating
Mouseover Content.

4 Select the mouseover bubble's background color for this layer.



46

JMap Pro 7 - User manual 
 
                                                                                  Copyright © 2001-2019 K2 Geospatial. All rights reserved.

Map Layers

5 The following options modify mouseover behavior.

· Mouse over visible: Enable or disable mouseover for the current layer.

· Prevent text duplication: Avoid having content repeat itself within a bubble. 

6 Visibility thresholds define the scale range within which mouseover bubbles are displayed on
the map. If you do not select this option, the mouseover bubble will be displayed at all scales. 

Creating Mouseover Content

You must provide the text that will be used as mouseover content. This text can include static parts
(displayed as is), variable parts (functions replaced by other values when the map is displayed),
simple javascript programs as well as HTML tags. For example, the elementValue(city) function, or
ev(city) in its abbreviated form, will be replaced by the value of the city attribute of the pointed
element, when displayed. 

The mouseover text can span multiple lines. Simply write the text over more than one line and the
mouseover bubble will use the same formatting.

Mouseover syntax

Mouseover syntax is comprised of various functions used to determine the contents of the bubbles.
Functions and their parameters are generally not case sensitive. For instance, ev(city) is equal
to Ev(CITY).

The following table explains the various functions that are available.

Function Description

elementValue(attrib) or ev(attrib)

attrib: the name of an attribute

Replaced by the value of the bound attribute
whose name is passed as a parameter for the
pointed element. For example, ev(id) will be
replaced by the value of the id attribute for this
element. 

elementId() Replaced by the element identifier.

polygonArea() Replaced by the area of a pointed polygon type
element.

lineLength() Replaced by the length of a pointed line type
element.

centroid() Replaced by the coordinates of the geometric
centroid of the element's geometry.
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format(attrib, format)

attrib: the name of a date or numerical attribute

format: the desired date format

Replaced by a number or date that was
formatted according to a specific format.

Example: format(date_insp,
dd/MM/yyyy)

where date_insp is the name of an attribute
containing a date and dd/MM/yyyy is the
desired date format, as indicated in the
documentation of the
java.text.SimpleDateFormat Java class.

Example: format(value, ##0,00)

where value is the name of an attribute
containing a number and ##0,00 is the desired
number format, as indicated in the
documentation of the java.text.NumberFormat
Java class.

ifNull(attrib, value)

attrib: the name of the attribute to test.

value: the value to display if attrib is null.

Replaced by the value value only if the value of
the attrib attribute is null. If the attribute value is
not null, nothing is displayed.

Example: ifNull(temp, N/A)

Displays N/A if the value of the temp attribute is
null.

Example: ifNull(attrib_a, attrib_b)

Displays the value of the attrib_b attribute if the
value of the attrib_a attribute is null.

ifNotNull(attrib, value)

attrib: the name of the attribute to test.

value: the value to display if attrib is not null.

Replaced by the value value only if the value of
the attrib attribute is not null. If the attribute value
is null, nothing is displayed. 

Example: ifNotNull(land_value, $)

Displays $ only if the value of land_value is not
null.

subString(attrib, startIx, endIx)

attrib: the name of the attribute for which a part
must be extracted.

startIx: starting position in the character string. 

endIx: ending position in the character string.

Replaced by a portion of the value (as a
character string) of the attrib attribute, between
the startIx position and endIx position.

Example: subString(name, 0, 5)

Replaced by the first five characters of the
name attribute value. If this value is Montreal,
the mouseover bubble will display Montr.
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encode(attrib, encoding)

attrib: the name of the attribute to code

encoding: the name of the encoding

Replaced by the value of the attrib attribute once
it is encoded with the specified character
encoding (UTF-8, CP437, ISO 8859-1, etc).

Example: encode(name, UTF-8)

Replaced by the value of the name attribute
encoded in UTF-8 characters.

<script> code JavaScript </script> Runs the javascript code found between the
tags. In javascript, the attribute values of the
elements are accessible through the
elementValue() or ev() function.

Mathematical operations or character string
operations can be performed on attribute
values. To display content in the bubble, the
script must call on the print() function.

Example: <script> print
( ev(population) / ev(area) );
</script>

Calculates and displays the result of the value of
the population attribute divided by the value of
the area attribute. 

Example: <script>
var KM_IN_MI = 0.621371;
var dist_mi = ev(km) * KM_IN_MI;
print('ev(osm_name)');
print(dist_mi.toFixed(1) + " mi");
</script>

Converts the distance in kilometers contained in
the value of the km attribute into miles. Displays
the value of the osm_name attribute (notice the
apostrophes (' ') because it is a character
string) and the distance in miles with a decimal
figure.

photos() Replaced by hyperlinks that allow you to open or
download the images attached to the element.
These images are photos taken on JMap Survey
or images selected with JMap Pro and
associated with map elements. 

photosAsThumbnails() Replaced by smaller versions of the images
attached to the element. The user can click on a
thumbnail to open the full size image. 
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projectName() Replaced by the name of the current project.

userName() Replaced by the user code of the user that is
currently logged in.

sessionId() Replaced by the identifier of the current session.

host() Replaced by the name of the host or address of
the JMap Server instance to which the
application is connected. 

port() Replaced by the port number (http or direct) of
the JMap Server instance to which the
application is connected.

date() Replaced by the current date and time.

HTML tags

The contents of the bubble can be formatted using simple HTML tags. Mouseover bubbles do not
support CSS or advanced tags such as <DIV>. The following HTML tags are supported and
frequently used in mouseover bubbles: 

<B>, <I>, <U>, <A>, <IMG>, <BR>, <TABLE>

You can insert hyperlinks in bubbles. These hyperlinks can be clicked, and they allow users to
open HTML pages or to open or download files. 

Examples

Mouseover content Display

City : ev(CITY)

A simple example of static text with
the value of an attribute.



50

JMap Pro 7 - User manual 
 
                                                                                  Copyright © 2001-2019 K2 Geospatial. All rights reserved.

Map Layers

City: ev(CITY)

(ev(COUNTRY))

Example containing static parts and
displaying 2 attribute values on 2
lines.

<b>ev(STATION_NAME)</b>

<a href="ev(URL)">Site web</a>

An example of basic formatting
using HTML tags and a hyperlink
where the URL comes from the
value of the URL attribute. 

<b>ev(DESCRIPTION)</b>

<img src="ev(IMAGE_URL)"
height="175" width="234" />

An example of an HTML tag that
takes the image URL from the value
of the IMAGE_URL attribute
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Area:

ev(AREA_KM2) km2

<script>

var SQ_KM_IN_SQ_MI =
2.58998811;

var area_sq_mi =
ev(AREA_KM2) /
SQ_KM_IN_SQ_MI;

println(area_sq_mi.toFixed(1) + "
sq. mi");

</script>

An example of a <script> tag with
JavaScript code. The value of the
AREA_KM2 attribute is converted
from square kilometers to square
miles. 

Locating Map Elements or Coordinates Using Mouseover

Mouseover supports a function to locate map coordinates or elements using a special URL syntax.
A hyperlink is displayed in the bubble and when clicked, the map locates the specified element(s)
or region. 

Mouseover locate example Description

<a href="locate:region;-73;45;5;5">Locate</a> Displays a Locate hyperlink. When clicked,
locates the region defined by x=-73, y = 45,
width = 5, height = 5 in the same map. This is
expressed in the map's units.

<a
href="locate:object;subway;name;'atwater'">Loc
ate</a>

Displays a Locate hyperlink. When clicked,
locates the elements on layer subway that have
their attribute name equal to atwater in the same
map.

<a href="locate:object;subway;name;'a
%'">Locate</a>

Displays a Locate hyperlink. When clicked,
locates in the same map the elements on layer
subway that have their attribute name starting
with letter a.
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<a
href="locate:object;subway;name;'atwater';1000
">Locate</a>

Displays a Locate hyperlink. When clicked,
locates the elements on layer subway that have
their attribute name equal to atwater in the same
map.The resulting map has a scale of 1 : 1000.

<a
href="locate:object;subway;name;'atwater':targe
t=Result">Locate</a>

Displays a Locate hyperlink. When clicked,
locates in a new map called Result the
elements on layer subway that have their
attribute name equal to atwater. If a map called
Result already exists, it is reused. If the name of
the map was new, a new map (with an
automatically generated name) would be
created each time.

Using a URL to Display Content

You can specify a URL that opens the contents of an HTML page in the mouseover bubble (only
supported in JMap Pro). The HTML page will occupy 100% of the bubble. The syntax is as follows:

$URL{http://awebsite.com}

The specified URL can be static or it can come from an attribute. It can also use attribute values as
parameters, as shown below:

$URL{http://awebsite.com?param1=ev(ATTRIB_A)&param2=ev(ATTRIB_B)}
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Filters

This section defines the filter parameters that can be applied to vector layers. You can filter the
elements of a layer by configuring a filter. Items that do not match the filter criteria are not
displayed.

Filter parameters interface

1 Check the box to enable the filter. Items that do not pass the filter are not displayed in the
layer. You can disable the filter without deleting it.

2 Attributes that make up the filter. Each attribute has an operator and an attribute value.
Operators vary depending on the attribute type.

3 Click the icon to add another attribute to the filter.
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The  icon next to the layer name indicates that a filter is enabled. The filter can be disabled by
unchecking the corresponding box. In this case all the elements of the layer are displayed and the

 icon indicates that a filter is configured for the layer.

Advanced

This section allows you to access advanced layer management settings. These settings are
normally used by system administrators.

Editable Layers

Some layers allow for data editing, which includes adding, moving, modifying and deleting
geometries as well as entering or modifying their attribute values and other data, using forms. This
is the case if the JMap administrator has given you permission to modify the contents of one or
more layers in a JMap project. Another case is when you use personal layers, which have been
created by you or other users who have granted you editing privileges. In both cases, editing tools
must be activated in the application.
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Editing Data

Two tools allow you to create, modify or delete elements on an editable layer. JMap's Edition
extension allows you to create new elements directly in a map-based interface and modify or
delete them. The elements explorer allows you modify attributes of existing elements or delete
existing elements.

Editing data with the Edition extension

The JMap administrator included this extension in the JMap Pro application. The user manual,
which can be accessed via your application's help menu, provides more details about this
extension's functions. 

If the edition tools are not visible, you can display them by selecting Edition in the View menu.

Graphical user interface of the Edition extension

1 Select the type of geometry you wish to create. Your selection must not be incompatible
with the type of layer (e.g. you cannot create polygons on a layer of points).

2 Select the layer on which you wish to create elements. If several editable layers have
been added to the project (including personal layers), they will all appear in this list.

Note: The layer named Annotations is not a personal layer. It is a generic layer on which
you can draw freely but it does not allow you to define attributes.

3 When you bring changes (add, modify, delete) to a personal layer, JMap stores the
transactions that should be saved.

Press  to save the layer transactions on the JMap server. 

Press  to reject the transactions and cancel all changes on the layer.

4 All editing operations can be canceled individually if they have not been saved. You can
also restore canceled actions by clicking on the Redo arrow.
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When the geometry is created, the attribute entry form displays. Here you can enter attribute
values. Some attributes are required. The form can only be closed once all required attributes have
been entered. 

Example of a form for entering attribute values

The attribute entry form can also be opened by right-clicking on a map element. 
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Pop-up menu displaying the attribute entry form

You can edit some of the metadata of photos of elements that was entered using a JMap Survey
application or uploaded as a file in the JMap Pro and JMap Web application forms. To do this:

1. Open the form of the element you want to edit using the Edit attributes function in the pop-up
menu. When the pointer moves over a photo, its name is displayed.

2. Double-click on a photo to open the metadata interface of the photo.

3. Edit the photo Title.

4. Press Enter to save the new title.

5. Press OK to close the metadata interface of the photo.

6. Press OK to close the form.

7. Save the changes in the interface of the Edit extension. You can see the new title in the
element form.
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The pop-up menu offers other editing tools. If you have a selection of map elements, you can
delete them or duplicate them on another editable layer. 
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The Edition extension also allows you to edit WKT elements. You can add WKT elements from
Tools -> Add WKT geometry in the menu bar. A window opens, allowing you to enter the
coordinates of the elements you want to add. 

The elements are added in the Annotations layer. They can be saved in a context, where they can
be selected and duplicated in other editable layers using the pop-up menu. This menu also allows
you to delete elements and modify their vertical position. 

The pop-up menu also allows you to edit WKT elements. The Edit WKT geometry function
displays the elements of the layers found at the map point where the context menu is open. Select
one of the elements to open the window containing the element's coordinates and data. If you have
the appropriate permissions, you can edit this data.

Batch editing the attributes of a set of elements

You can batch edit the attributes of a selection of elements from certain layers. Indeed, when a
layer contains forms with subforms, you can edit the attributes of a subform in batches, for a set of
elements you have selected. 

The following figure illustrates this process.

1. Select elements from a layer.

2. Open the attributes form of the selected elements using the pop-up menu. In the following
example, the Permis subform displays the attributes of the selected elements. 
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3. Select the records you wish to modify and press Edit.... In the example the Permis subform
displays.
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4. Modify the attribute values for the set of selected elements.

Editing Elements in the Elements Explorer

Element attribute values can be entered or modified directly in the elements explorer of an editable

layer. Edit mode must be enabled by pressing .

1 Press  to enable edit mode. In this mode, all modifiable attribute values can be entered or
changed. Afterward, click on a field to change its value. Date fields display a calendar to
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facilitate data entry. Values that are entered are validated in order to ensure their compatibility
with the attribute type.

For more information on how to use the elements explorer, refer to Elements Explorer.

2 Click on a field to enter or modify the attribute value. 

3 Some of the attributes that are displayed cannot be edited (Author, Creation Time,
Modification Time, ID JMap). These are system attributes and their values are automatically
set by JMap.

Layer elements can also be deleted if Edit mode is enabled. 

1 Select the element you want to delete. Press Delete on your computer keyboard. 

2 The element disappears from the elements explorer. 

3 The transaction must be saved in the Edition extension's window.
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Personal Layers

Personal layers are editable map data layers created by users. When you create a personal layer,
you assign it a name, a type (point, line, polygon), a style, and a list of attributes. You can then
begin to add map elements to it by drawing them using JMap's editing tools. You can also enter
values for the layer's element attributes. Personal layers can be shared between users; various
access levels can be defined for these purposes.

The personal layer management interface shows you a list of the personal layers you can access.
These layers may have been created by you or by other users who shared them with you. This
window can be accessed through the Project -> Personal layers... menu or by pressing
CTRL+L.

NOTE: Special privileges are required to create personal layers. Contact your JMap administrator
for more information.

Personal layer management interface

1 Click on  to create a new personal layer.

Click on  to erase the selected personal layer.

Click on  to share the selected personal layer.

2 The filter field allows you to filter the list of personal layers; to do so, type a few letters of the
names of the layers you wish to retrieve.
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3 Layers that are checked are added to the project's layers. Personal layers can be added to a
project or removed from it at any time.

4 This section displays your access privileges in relation to the project's various personal
layers. Keep in mind that the Read permission, which allows you to display data, is implied
for all of the personal layers you have access to. 

· Owner: This permission indicates that you are the owner of the layer, which allows you to
modify or delete it. In addition, being the owner of a layer allows you to share it with other
users. Note that the Owner permission automatically gives you Write permission.

· Write: This permission allows you to add, modify, and delete elements on the layer. You
can also modify the values of element attributes.

Creating and Modifying a Personal Layer

Interface for creating and modifying personal layers

1 Name: Enter the name of the layer. Names do not have to be unique, but we recommend
using names that have meaning; spaces can be used in the names.

Type: Indicate which type of elements (point, line or polygon) the layer will contain.
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2 Press this button to configure the style of layer elements. 

3 You can define a list of attributes for the layer. The values of these attributes can be entered
using a form or the elements explorer.

Press  to add an attribute to the personal layer.

Press  to remove an attribute from the personal layer.

If needed, press  and select a layer to copy the attributes list of an existing layer. 

4 This table presents the list of attributes defined for the personal layer. When adding a new
attribute, you can enter its name and the type of data it will contain.

Note: It is impossible to change the name and type of an existing attribute. 

Sharing Personal Layers

Personal layers can be shared with other users according to various access levels. The following
permissions are available.

Permissions

Read Allows the user to add the layer to his or her project and display its
data on the map.

Write A user who has this access privilege automatically inherits the read
permission. In addition, the user can create, modify, and delete the
personal layer's geometric and descriptive data (attributes).

Owner A user who has this permission automatically inherits read and write
permissions. In addition, the user can modify the personal layer's
settings, delete it or share it with other users.

In order to share a personal layer, click on the Share icon in the personal layer management
window. The following window appears and shows the list of users, allowing you to define
permissions for each one. 
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Personal layer permission management interface
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Labeling Tools

In JMap, labels are text values attached to map elements. They are used to display the attribute
values of a layer's elements. For instance, labels can display street names on a linear road system
or names of cities represented on the map by points.

Labels can either be placed manually or generated automatically by JMap when the data is
displayed. The labeling tool is only used for manually created labels.

 Add labels 

Allows you to manually create a label by clicking on a map element. The label is displayed
according to the settings that have been configured for the element's layer.

 Remove labels 

Press this button to delete all labels that have been added manually.

Note: Labels can be deleted individually by doing the following: enable the labeling tool, press and
hold the ALT key and click on the label you wish to delete.

Examples of labels

Selection Tools

You can select elements on vector layers only. The selected elements can be used to perform
various actions, such as running an information report, spatial analysis, editing, etc. Several
selection tools are available. Note that to select layer elements, the layer must be selectable (refer
to the section on layer settings).
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List of available selection tools   Number of selected elements is indicated

 Punctual selection

Select a single element by clicking on it. When several elements are superimposed, only the top
one is selected. Enable the tool and click on an element in the map.

 Rectangular selection

Select one or more elements by tracing a rectangle. All elements that are completely or partially
included in the rectangle are selected. The rectangle's dimensions are displayed. Enable the tool
and trace a rectangle on the map.

 Circular selection

Select one or more elements by tracing a circle. All elements that are entirely or partially included in
the circle are selected. The circle's radius is displayed. Enable the tool and trace a circle on the
map.

 Polygonal selection

Select one or more elements by tracing a polygon. All elements that are entirely or partially included
in the polygon are selected. The dimensions of the polygon are displayed. Enable the tool and trace
a polygon on the map. Double-click or press the spacebar to complete the polygon. 

 Linear selection

Select one or more elements by tracing a line. All elements on the line's path will be selected.
Enable the tool and trace a line on the map; double-click or press the spacebar to complete the
line.

Note: this option does not work with map points.

 Clear selection
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Unselect all selected elements on the map.

Note: Using any selection tool, you can press and hold the CTRL key to add or remove elements in
an existing selection.

Selection tools are compatible with the snap function (refer to the Snap Tools section).

Selection Explorer

The selection explorer displays the attributes that are bound to the selected elements in the layers.
Each layer is represented by a tab; the interface allows you to access all selected elements at any
time, regardless of the layer they belong to. The selection explorer functions in a similar way to the
elements explorer except that it only presents the map's selected elements (refer to the Elements
Explorer section).

Selection explorer

1 Each layer that contains selected elements is represented by a tab, which indicates the
name of the layer and the number of selected objects.

2 A message indicates the total number of selected objects and the number of layers the
selection spans.

3 All elements that are listed are selected. If you unselect an element, it disappears from the
table.

Information Tools

JMap includes several tools that provide information on map elements.

 Information report

This tool opens an information report related to the map elements. Reports display descriptive data
pertaining to the pointed elements. They are defined by the JMap administrator. Enable the tool and
click on one of the map's elements. If several elements of one or more layers are pointed, several
reports will be available in the same window, but only one can be viewed at a time.
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Information reports on 2 layers

1 The top portion of the report displays the names of the layers for which information reports
are available at the pointed area.

2 Clicking on a given layer allows you to view its list of available reports; the first report is
automatically displayed.

3 The contents of the displayed report can be exported towards an Excel file or printed. There
are also more advanced reports that allow you to export individual attributes to a CSV file.

4 Information contained in the report is configured by the JMap administrator. It can originate
from the layer itself or from other data sources associated with the map layer. 

 Select information report

This tool allows you to open an information report containing information on all of the selected
elements. Select elements and open the report by clicking on the information reports icon.
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Information report on selection

1 The names of the layers on which selections have been performed are displayed at the top of
the report.

2 Clicking on a given layer allows you to view its list of available reports; the first report is
automatically displayed.

3 The contents of the report displayed can be exported in individual columns to a CSV file,
exported in whole to an Excel file, or printed. 

4 Information contained in the report is configured by the JMap administrator. It can originate
from the layer itself or from other data sources associated with the map layer.

 Geometry information

This tool allows you to obtain information on the geometry of the map's elements. The information
varies according to the type of geometry (point, line, polygon, etc.) and the number of selected
elements. Select one or more elements on the map and click on the button for this tool. 
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Geometry information on a single map element

Geometry information on multiple map elements

Mouseover

Mouseover bubbles contain information on map elements. They are automatically displayed when
the mouse pointer remains on the elements of certain layers. Mouseover bubbles can contain
attribute values, links to web pages, images, etc. When several elements are superimposed,
mouseover bubbles display the information for all the elements, grouped by layer.
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Mouseover bubbles can be used to display HTML content and images.

The color of mouseover bubbles can be configured (refer to Layer Settings). It can be different for
each information layer. 
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The color of the bubble can be modified.

Mouseover bubbles can be pinned to the screen in order to be displayed persistently. To pin a
mouseover bubble, click on the icon located in its upper left corner. 

You can select and copy the contents of a mouseover bubble by clicking on the icon located in its
upper left corner and pasting it in another document (Word, Excel, etc.) using the Ctrl-C and Ctrl-
V keyboard shortcuts.

The bubble can be displayed persistently.

You can also adjust the delay before the mouseover bubbles appear, according to your
preferences (refer to the Application Settings section).

You can also disable all mouseover bubbles on the map by clicking on the  button located in the
lower left part of the map.
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Snap Tools

Most of the tools for drawing map objects (measurement tools, selection tools, editing tools, etc.)
can be used with the snap function, which snaps the pointer to existing elements. This is useful to
measure the exact distance between two elements, for example.

The menu found on the status bar of the map displays the parts of elements on which you can
snap the pointer. Press the arrow to open the menu and select by checking the snap options. Click

on  to enable the snap feature. The icon goes dark. Press the icon again to disable the function.
Your snap options remain selected.

Line

You can snap the pointer to the closest line on the map.

Snap tool (line)

Node

You can snap the pointer to the closest node on the map.

Snap node (node)
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Middle

This option allows you to snap the pointer in the middle of a line or of a polygon's segment.

Snap middle

Intersection

This option allows you to snap the pointer at the intersection of two lines.

Snap intersection

Perpendicular

This option allows you to snap the pointer to a line or polygon segment perpendicularly.

Snap perpendicular
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Measurement Tools

Measurement tools allow you to calculate distances and surfaces (area and perimeter).
Measurements remain on the map until they are erased, allowing you to make several
measurements, to print these with the map and save them in map contexts.

 Distance measurement

The distance measurement tool allows you to calculate the distance between two points at a bird's
eye view. The tool allows you to measure multiple segments; you then obtain the distance of each
individual segment as well as the total distance of all segments. The measured distances are
persistent, meaning they remain on the map until the user erases them.

1. Enable the tool.

2. Click on the desired area of the map once to get started.

3. Click on the desired area of the map to complete each segment.

4. Double-click on the map or press the spacebar to complete the measurement and display the
total distance.

Distance measurement
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Surface measurement

The surface measurement tool allows you to measure areas and perimeters by tracing a polygon
on the map. The measurements are persistent, meaning they remain on the map until the user
erases them.

1. Enable the tool.

2. Click on the desired area of the map once to get started.

3. Click on the desired area of the map to complete a segment; repeat if desired.

4. Double-click on the map or press the spacebar to close up the polygon, complete the
measurement and display the results.

Surface measurement

 Erase measures

Measurements remain on the map until they are erased. Press this button to erase all of them.

Note: Measurements can be erased one at a time by following these steps: 
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1. Enable measurement tool (distance or surface).

2. Press and hold the ALT key.

3. Click on the measurement you wish to erase.

Measurement tools are compatible with the snap function (refer to Snap Tools).

Note: To obtain the geometric properties of a map element (length, area, centroid, etc.), you can
use the geometry information tool (refer to the Information Tools section) instead of the
measurement tool.
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Search Tools

Search tools allow you to find elements on the map using spatial (spatial query) or descriptive
(attribute query) criteria. Attribute queries are defined in advance by the JMap administrator. The
search window displays all available queries.

Search window
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 Attribute Queries

Attribute queries are used to find specific elements on a layer using the layer's attribute values. By
entering search parameters in the search form (defined by the system administrator), a query is
performed in order to select the map elements meeting the criteria and display them in the
elements explorer. Contact your system administrator for more information on available queries.

Attribute query

 

1 Enter data in the form's fields. In this example, select the name of the element you are
searching for in the list. You can type just a few letters; the list will show the values that
contain them.

2 Press the Options button to display a list of search options. The following options are
available:
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· Search only in current extent: The query will only be performed in the visible area on the
screen.

· Search only in current selection: The query will only be performed in the elements that
have been previously selected.

· Add to current selection: The results of the query will be added to the elements on the
map that have already been selected.

· Show result list: Displays the results list in the elements explorer. 

· Always show selection: Displays results, even when these do not fall within the visibility
thresholds of the layers that are queried (this is useful when results span a very large
territory).

· Add labels on selected elements: Displays a label on each element that is found
(improves visibility of results).

3 Press Search to launch the query. Press Reset to reset the form.

Results are selected on the map. If the Show result list option is selected, the elements explorer
displays the elements returned by the query. It is then possible to launch an information report
pertaining to the selection (refer to Information Tools).

 Spatial Queries

Spatial queries are used to search for map elements of a layer that meet a spatial criterion. Several
types of spatial criteria are available, but each uses a reference selection as a basis for the search.
Therefore, before performing the spatial query, it is essential that you select the reference
elements. 

Some examples of spatial queries:

· Select properties located at less than 500 meters from the selected park.

· Select route segments located within the selected zoning polygon.

· Select all lots adjacent to the selected river.
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Spatial queries

1 Select the information layer on which the search is performed (what you are looking for). The
spatial query can only be performed on a selection that has been made beforehand.

2 Press the Options button to display a list of search options. The following options are
available:

· Search only in current extent: The search is performed only on the area that appears on
the screen. 

· Search only in current selection: The search is performed only among the elements that
are already selected.

· Add to current selection: The results of the query will be added to the elements on the
map that have already been selected.

· Show result list: Displays the results list in the elements explorer.

· Always show selection: Displays results, even when these do not fall within the visibility
thresholds of the layers that are queried (this is useful when results span a very large
territory).

· Add labels on selected elements: Displays a label on each element that is found
(improves visibility of results).
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3 Choose the spatial criteria to apply for the query. 

4 Press Search to launch the query. 

Results are selected on the map. If the Show result list option is selected, the elements explorer
displays the elements returned by the query. It is then possible to launch an information report
pertaining to the selection (refer to Information Tools).
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Collaboration Tools

Map Contexts

Map contexts are comprised of all the settings required to recreate a geographical map. They allow
you to save a map and also share it with other users. Existing contexts can be easily retrieved to
recreate a map environment. All layer settings, annotations, thematics, selections, etc. are part of
the context and are recreated when it is opened.

Note: A context is associated with the project in which it was created. It cannot be accessed from
other projects.

Create a New Context

1. Go to Project -> Contexts... and click on the  button from the context window. 

Creating a new context
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1 Enter a name for the context. If the name already exists, you will be prompted for a
confirmation before overwriting the context with the same name. When creating a new
context, the settings of the displayed map are saved according to the selected options.

2 The following options are available:

· Annotations: Include the list of selected objects, the user's drawings, the labels added to
the map, and the distance and surface measurements.

· Measures: Include measurements made on the map.

· Layers settings: Include layer settings (visibility, order, styles, filters, etc.).

· User labels: Include labels displayed on the map.

· Markers: Include markers for the points the user has searched for and located by entering
coordinates.

· View settings: Include settings of the displayed map (scale, area displayed, units, etc.).

If an option is not selected, the settings associated with it are ignored and are not part of the
context. When the context is opened, these settings will not be affected. Certain options may
not be available if they do not apply.

The new context appears in a list of the user's private contexts.



87

JMap Pro 7 - User manual 
 
                                                                                  Copyright © 2001-2019 K2 Geospatial. All rights reserved.

Collaboration Tools

List of existing contexts

1 The following options are available:

· Open: Select the context to open and click on the button to display it.

· Save context...: Click on this button to create a new context from the displayed map.

· Delete: Select the context to delete and click on the button to delete it.

· Make public: Select the context you wish to make public and click on the button to make it
accessible to all users.

· Send a copy: Select the context you wish to send and choose the recipient in the list. The
recipient will then see a pop-up in JMap notifying him or her that a context has been added
to his or her list of private contexts.

· Change projection: This advanced function allows you to change the projection
associated with a context. This can be useful after an administrator has changed the
projection of a JMap project. 
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2 Click on the tab associated with the list of contexts to be viewed (public or private).

3 When entering a query in this search field, only the contexts whose names include the
contents of the query will be displayed.

4 List of contexts showing the author and creation date of each context.

5 Allows you to select a context that will be displayed by default when a JMap session is
opened. Only one context can be defined with this option. 

6 Information on the context that is entered when it is created, along with a preview of the
context.

 Opening a Context

Open the context management window in Project -> Contexts....

The context management window displays the list of existing contexts for the current project. The
list is divided into 2 sections: the private section displays your list of private contexts (which only
you can access) and the public section shows the list of public contexts (shared by users and
accessible to all users who have access to the project).

Contexts can be sorted by clicking on the column headers in the list.

To open a context, select the context in the list and press the  button or double-click on the
context in the list. After a context is opened, the active view displays the map. The context window
stays on the screen to allow you to open another context. 

 Sending a Context to Other Users

Open the context management window in Project -> Contexts....

JMap allows you to send a copy of a map context to one or more users. The context will appear in
each recipient's private section. Recipients are the owners of their copies and can modify or delete
them.

In order to send a context, select it in the list and press the Send a copy button . A window
displays, allowing you to select recipients. 

Select one or more users or groups who will receive a copy of the context. When groups are
selected, all members receive a copy. Press Ok.

 Making a Context Public

Open the context management window in Project -> Contexts....
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A public context appears in the public section. A public context is in fact a private context that a
user has decided to share with the other persons who have access to the project; all of these
users can open the public context. Once it is shared, the context remains in the user's private
section, and a copy of it appears in the public section. Only the user who shared the context can
modify or delete it.

To make a context public, select it in the list and press the Make public button .

 Deleting a Context

Open the context management window in Project -> Contexts....

To delete a context, select it in the list and press the Delete button . Only the owner of a public
context can delete it.

Note: A context that has been deleted cannot be restored.

Load a Context by Default

Open the context management window in Project -> Contexts....

A context (private or public) can be loaded automatically when opening a project.

Select the context to be loaded automatically when the project is opened. Only one project can be
selected. To cancel this function, simply re-click in the check box of the selected context.

Sharing Maps

JMap allows you to create and share map images. You can copy a map to the clipboard and paste
it into another application, send a map by email or save an image of the map in a file. These
functions are accessed via the map's pop-up menu (right-click on the map). 
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Copying a Map to the Clipboard

You can copy a map to the clipboard and paste it to another application (word processor,
presentation software, email, etc.). Access the pop-up menu by right-clicking on the map and
selecting Share... -> Copy to clipboard. Afterwards, you can use the Paste function in the
application that will receive the image.

Saving a Map Image

You can save a map image in a file. Use the pop-up menu by right-clicking on the map and
selecting Share... -> Save as.... You must then select a target directory and enter a name for the
file.

Sending a Map by Email

JMap allows you to send an image of a map by email. Use the pop-up menu by right-clicking on the
map and choosing Share... -> Mail this map. You can select JMap users to whom you wish to
send the map or enter the recipients directly in the designated field (use a semicolon (;) to separate
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addresses). Groups can be used as lists of recipients. The map will be added to the email as an
attachment.

Email window

1 Choose the email recipient among all JMap users by clicking on the To... button or enter the
address of the recipient. Enter a subject for your email.

2 Choose the image format to apply to the email attachment. You can also enter text that will
accompany the map image.

Printing Maps

 JMap's printing tool allows you to print maps with advanced page setup options. The print
layouts are predefined page setups you can use for printing purposes. You can create your own
layouts, and the JMap administrator can provide layouts that can be used by all users. You can
also ask the JMap administrator to make your personal layouts public. The settings made in the
print interface are saved automatically when you close your session.
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Print window

1 Select the layout you wish to use. There is always at least one default layout. Refer to Print
Layouts for more information on layouts.

2 Select the paper format and the printing orientation. JMap can print maps on many different
paper formats, from very small to very large. 

3 Select the print quality and type (color or grayscale). A high-quality print requires more time. 

4 This section allows you to configure aspects such as the scale, borders, and grid of the map.
For more information, refer to the Map Printing Properties section.

5 Variables are text that is replaced by user-defined values when the map is printed. The table
shows all variables that are available in the selected layout. To modify a value, double-click
on it and enter the new value. 

6 You can modify the page setup of the map using a preview of it. For more information, refer
to the Map Page Setup section. 
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7 Click on Layouts... to open the layout management window. Refer to the Print Layouts
section for more information on layouts. 

Print Layouts

 Print layouts are used to define the page setup for printing. You can create your own layouts
and use them according to your needs. Layouts also allow you to define a wide variety of display
options. When defining the page setup of a layout, each element of the layout can be moved and
resized using the mouse. Each element has its own settings window that can be accessed by
double-clicking on the element. 

To open the templates window, click on the Print layouts option in the Printing tools from the
toolbar, or click on the Layouts... button in the Print window.

Print layouts window

1 The list of existing layouts. The default layout is indicated in the right column. 

2 A preview of the selected layout. 

3 Click on these buttons to:

  Create a new layout.



94

JMap Pro 7 - User manual 
 
                                                                                  Copyright © 2001-2019 K2 Geospatial. All rights reserved.

Collaboration Tools

 Edit selected layout.

 Delete selected layout.

 Rename selected layout.

 Duplicate selected layout.

 Assign selected layout as default layout.

 Remove default layout status from selected layout.

Map Printing Properties

The map's printing properties can be configured directly in the printing interface, or they can be
defined when configuring a print layout. In the latter case, double-click on one of the layout's maps
and open its Properties window. Both methods offer the same options to control the map's
appearance for printing purposes. 
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Map settings window for printing

1 Scale: Printing can be done according to the scale displayed on the screen or according to
the displayed region. If you choose the Current scale option, JMap will print the map
according to the same scale as displayed on the screen, but the area printed can change,
depending on the size of the map and paper. If you choose Fixed scale, you can enter a
different scale. The Fixed extent option allows you to adapt the map to the paper format
used to ensure the printed area is at least as big as the area displayed on the screen.

2 Border: This option allows you to add a border around the map. 

3 Grid: You can add a grid on the map. This grid will show divisions and subdivisions of the
coordinates system. 
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Map Page Setup 

The map's page setup can be configured directly from the printing interface or when creating or
modifying a layout. In both cases, the interfaces offer the same tools. The following figure shows
the layout configuration window. 

Page setup window of a print layout

1 Select the paper format and orientation of the layout. 

2 Define the margins used in the layout. 
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3 Click on this button to add a text element on the page. The new element appears in the upper
left corner of the page. Double-click on the text to modify its parameters (text, alignment, font,
etc.). 

To insert a variable in the text, use the following syntax: var(name) , where name is the name
of the variable. This function will be replaced by the value of the variable.

4 Click on this button to add an additional map on the page. 

By default, the map that is active when the print function is executed will be displayed in full
size. However, all maps that are open in JMap Pro will also be available for the creation of the
layout. When you add a map on the page, double-click on it to access its parameters window
and select the map to display. For more information, refer to Map Printing Properties.

5 Click on this button to add a table on the page. Each cell of the table can contain text. Double-
click on the table to access its parameters window. 

6 Click on this button to add a legend on the page. The legend can be customized to display
only the desired layers. Double-click on the legend to access its parameters window. 

7 Click on this button to add a north arrow on the page. The arrow can be customized. Double-
click on the arrow to access its parameters window. 

8 Click on this button to add a graphic or textual scale on the page. Double-click on the scale to
access its parameters window. 

9 Click on this button to add an image on the page. You must choose an image by navigating
through the file system of your computer. Double-click on the image to access its
parameters window. 

10 If you select one or more elements, this button allows you to align them to the page's margins
and place them in the page.

If you select several elements, you can also align them in relation to each other.

11 Click on this button to reset the page setup.

12 You can adjust the zoom in the layout window to define the size of the page or click on  to
adjust the page to the size of the window. 

Double-clicking on the map displayed opens the Map Printing Properties window.
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Application Settings

Application settings are accessed from the Tools -> Application settings... menu.

Application settings

Preferences

The available option allows you to define the display delay of mouseover bubbles on the map. Enter
the delay time required in the field. This information will be saved in the user's preferences and
does not need to be redefined each time the user logs on. The default value is 400 ms.

Connection

This section allows you to configure options for the connection between the JMap application and
JMap server. 
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Pending requests

This section allows you to manage the execution of pending requests, which are requests that are
waiting to be sent to the JMap server after work has been done in offline mode.

Disk cache

This section allows you to define the size of the local computer's disk cache. 
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Keyboard and Mouse Shortcuts

General

Ctrl+S Load another project.

Ctrl+Shift+S Save a new context.

Ctrl+Shift+C Display the context management window.

Ctrl+L Display the personal layer management window.

Ctrl+O Display the map overview.

Ctrl+E Display the elements explorer.

Crtl+G Go to coordinates on the map.

Ctrl+N Open a new map.

Ctrl+Shift+H Organize open maps horizontally.

Ctrl+Shift+V Organize open maps vertically.

Ctrl+Shift+G Group all open maps into tabs.

F1 Open JMap online help.

M When moving the cursor over the map, press to display an enlargement of the
area surrounding the cursor.

Navigation

1 Move towards the bottom-left.

2 Move towards the bottom.

3 Move towards the bottom-right.

4 Move towards the left.

6 Move towards the right.

7 Move toward the top-left.
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8 Move towards the top.

9 Move towards the top-right.

+ Zoom in.

- Zoom out.

* Rotate clockwise.

/ Rotate counterclockwise.

Up arrow Move towards the top.

Left arrow Move towards the left.

Right arrow Move towards the right.

Down arrow Move towards the bottom.

Pressing the
button at the
center of the
mouse or holding
down the mouse
wheel

Move the map according to mouse movements.

Mouse wheel Zoom in or zoom out, depending on which direction the mouse wheel is
rotated.

Edition

Ctrl 1 - Snap the cursor to the closest node on the map.

2 - Keep only the results of a spatial operation by eliminating initial elements.

Shift Snap the cursor to the closest line on the map.

Alt Trace a line oriented according to an angle that is a multiple of 45 degrees.

Space Complete drawing action by eliminating the last segment.

Esc Cancel drawing operation.
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Measurements

Ctrl Snap the cursor to the closest node on the map.

Shift Snap the cursor to the closest line on the map.

Alt 1 - Trace a line oriented according to an angle that is a multiple of 45 degrees.

2 - Erase an existing measurement by clicking on it.

Space End measurement action by eliminating the last segment.

Esc Cancel measurement operation.

Labels

Alt Erase a manually created label by clicking on it.

Selection

Ctrl 1 - Snap the cursor to the closest node on the map.

2 - Add or delete selected elements.

Shift Snap the cursor to the closest line on the map.

Alt Trace a line oriented according to an angle that is a multiple of 45 degrees.

Space Complete selection operation by eliminating the last segment.

Esc Cancel selection operation.


